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Assignment 9:  

Color Theory for Computer and Print 

CMYK Color Wheel  
 

Art 213 - Color Theory, Spring 2020, East Los Angeles College 

 

Professor: Christine Frerichs (frericcj@laccd.edu) 

 

Student: Edward Locke (edwardnlocke2020iphone@gmail.com) 

 

Date Due: Friday, May 8, 2020  
 

Your assignment is to make a 12-part Color Wheel using only Cyan, Magenta, Yellow and Black 

(known as “Key”) - CMYK.  Making this color wheel will deepen your understanding of the 

color system used by printers (CMYK).  Concepts include opacity, translucency and optical 

mixing.    

For the chance at full credit, use the provided color wheel template and organize your assignment 

in the exact format shown to you in class.  Please read the instructions below and also refer to the 

diagram as seen in the PowerPoint lecture from today.  There are 4 rings to this color wheel:  

Ring 1 - The inner most ring should be filled with your “Key Color”, made by mixing Cyan, 

Magenta and Yellow.  Just as printers do, you can add a dab of black paint to this three-color 

mixture to achieve a darker Key color.  

Ring 2 - In the next ring of the color wheel, you will mix your 12 colors (using only cyan, 

magenta and yellow to mix) and apply the paint in an opaque (not see-through) manner.  Please 

arrange your colors on this wheel just as you were required to do for your 12-part color wheel 

from Week 2 (yellow at 12 o’clock, magenta at 4 o’clock and cyan at 8 o’clock). 

Ring 3 – This ring will contain all 12 colors painted in a translucent (see-through) manner.  Mix 

your Matte Medium with your Acryla-Gouache to achieve a translucent paint.  IMPORTANT: 

YOU CAN ONLY USE YELLOW, CYAN AND MAGENTA RIGHT OUT OF THE TUBE 

FOR THIS RING.  As demonstrated in class, you will layer your colors in this ring, to achieve 

the secondary and tertiary colors.  In other words, to achieve the look of orange, you will first 

paint a translucent layer of yellow to the white surface and let that dry.  Then you will paint a 

translucent layer of magenta over the translucent yellow.  The two layers together will appear 

orange to our eyes.  You can also paint a layer of translucent magenta down first, let it dry, then 

paint translucent yellow on top.  The order in which you layer the paint does have an impact on 

how the final result is seen.  Another example: If you want to make red-orange, you can first put 

down a layer of translucent magenta (a little more magenta paint and a little less matte medium), 

let it dry, and then put it layer of translucent yellow on top (a little less yellow paint and more 

matte medium).  That will create the look of a red-orange. 
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Ring 4 – This ring will demonstrate the concept of “Optical Mixing”, as defined in our 

lecture.  You may choose to use dots, dashes, thin lines and any other small mark to apply the 

colors.   You should only be using Yellow, Magenta and Cyan for these dots.  You can use 

translucent, opaque or a combination of translucent or opaque dots here, for different results.     

Once finished with your 4-ring CMYK Color Wheel, you will decide on a black and white 

pattern for the background (area outside of the color wheel on your white paper).  In this area 

around the CMYK Color Wheel, you can use black pen or black paint to draw or paint anything 

you want.  Again, it must be in black and white, so as to enhance and not distract from the colors 

of the wheel.  Some examples include patterns (dots, lines, organic shapes, flowers), doodles, 

song lyrics, your name repeated, your motto in life, little cartoon characters, etc. The best 

looking assignments will fill the background space entirely (from the edges of the wheel to the 

edges of the 11” x 14” paper) with some type of imagery or pattern.    

Please take TWO photographs of this assignment to post on Canvas.  One photo will be of the 

entire 11” x 14” paper.  The other photograph will be a close up shot of the color wheel. This 

assignment will be graded on how well it followed directions of the handout, the demonstrated 

knowledge of CMYK color mixing in opaque, translucent and optical mixing ways, the 

inventiveness of the black and white background, and the overall craftsmanship (neatness) of the 

finished work.  
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Part 1:  

Color Wheel Painted with Gouache 

I strictly followed all instructions to create the color wheel with four rings, with Matte Medium 

and Acryla-Gouache on 11” x 14” Bristol paper. With regard to the creation of the background 

with a black and white pattern, I made some changes with the Instructor’s approval:  

1. I used cyan, yellow and magenta, the three primary colors, to create symbols of heart, star, 

women’s power, and peace, when I painted relevant colors on the Color Wheel; I repeated 

the same techniques for all three primary colors; and with overlaying of colors, secondary 

colors (green, violet, and orange) were created; the same is true for the tertiary colors, such 

as red-violet, red-orange, yellow-orange, yellow-green, blue-green, and blue violet. 

2. I took a picture of the finished Color Wheel and colorful background; I copied the picture 

from my i-phone into my computer; and I edited the image to change the colorful 

background into a grayscale image.     

 

The completed Ring1 and Ring 2, with yellow color being painted together with paint strokes for 

the symbols. 
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The completed Ring1 and Ring 2, with partially completed Ring 3 and Ring 4, with magenta 

color being painted together with paint strokes for the symbols, next to or over the yellow paint 

strokes. 

 

The completed Ring1, Ring 2, Ring 3 and Ring 4, with cyan color being painted together with 

paint strokes for the symbols, next to or over the yellow and magenta paint strokes. 
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Enlarged image of the Color Wheel. 

 

The completed assignment after the background has been changed into a grayscale image, in the 

Hue/Saturation menu or through Image→Mode→Grayscale menu (THIS IS THE 

COMPLETED ASSIGNMENT FOR SUBMISSION). 
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Part 2:  

Color Wheel Created with Adobe Photoshop 

For extra-credit, I created a 11” x 14” 300dpi CMYK Photoshop file to study and demonstrate 

the techniques to be used in Adobe Photoshop program in order to complete the same 

assignment. I first turned on the Rulers and Snap options in the View menu; I next dragged a 

horizontal guide from the horizontal ruler to the 5.5” middle point of the vertical edge, and a 

vertical guide from the vertical ruler to the 7” middle point on the horizontal edge, so that I could 

create concentric rings from the center point of the digital space. I pressed both Ctrl and S key to 

save the file with a convenient name in a convenient location. I saved often throughout all steps. 

In the Apple computers, the equivalent key for Ctrl is Command key.   

For Ring 1: Next I went to the Window→Swatches menu to open the Swatches window; I 

clicked the Pure Cyan swatch to select the color; next, I created a new layer and named it Cyan 

in the Layer panel; I selected the Elliptical Marquee tool from the Tool bar, held both Shift and 

Alt keys while clicking at the center of the digital space where the vertical and horizontal guides 

meet and dragged to create a circle; next, I selected the Paint Bucket tool and clicked inside the 

circular marquee to paint it with the Cyan color; I repeated this process to create another two 

layers for the Pure Magenta and Pure Yellow colors, above the previous Cyan layer, and changed 

their opacity or transparency from 100% to 50%. This created a black circle (Ring 1) at the 

center of the digital paper. To verify that the color is really black, I create another circle and used 

the Black swatch from the Swatches window for comparison; the color match was perfect. I 

named the layer Ring 1.  

 

 

 

 

 

 

 

 

 

The Pure Cyan 

color from the 

Swatches panel, 

and the Elliptical 

Marquee and 

Paint Bucket tools 

from the Tool bar.    
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The Ring 1 completed. 

 

The empty color wheel outlines. 

For Ring 2: I needed an empty color wheel with outlines separating the color slices. I went to 

Google Image Search; selected one with 12 colors, right-clicked the image for the shortcut menu 
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and chose the Copy Image option; I returned to Photoshop, pressed both Ctrl and N keys and I 

clicked the OK button in the New File window, to create a new file with the same size as the 

image; I pressed both Ctrl and V keys simultaneously to past the image; I selected the Magic 

Wand tool from the Tool bar, held the Shift key, clicked on the color slices one by one, and 

pressed the Delete key on the keyboard to remove the colors; next, I pressed both Ctrl and A 

keys to select the outlined color wheel, and both Ctrl and C key to copy it to the clipboard; I 

returned to the color wheel file and pressed both Ctrl and V keys; the outlined but empty color 

wheel was pasted right at the middle of the space; I named the layer containing this image Ring 

2; and I pressed both Ctrl and T keys at the same time to change the size of the color wheel; I 

held both Shift and Alt (or Option in Apple computers) keys, and dragged one of the Transform 

frame’s four corner points to change the size while maintaining its center point and proportions; 

next, I repeated the same process to create layers for Ring 3 and Ring 4. For convenience, I 

turned off the Visibility for both Ring 3 and Ring 4 layers. 

For the Primary Colors: Cyan, Magenta and Yellow are the Primary Colors; they cannot be 

mixed from other colors. I selected the Magic Wand tool and clicked on the empty slice for 

Yellow color; I clicked on the Pure Yellow color swatch in the Swatches panel’s Pure folder; I 

selected the Paint Bucket tool, and clicked on the marquee selected to fill in the Yellow color; I 

repeated the same process for the Cyan and Magenta colors.  

For the Secondary Colors: Green, Orange and Violet are the Secondary Colors, which are 

mixtures of two neighboring Primary Colors. I created the first set of Primary Colors in the same 

layer containing the Primary Colors; next, I created a new layer with the second set of Primary 

Colors, and turned its Opacity to 5% in the Layers panel, to complete the Secondary Colors. This 

is explained in details below: 

1. For the Orange color: I selected the Magic Wand tool and clicked on the empty slice for 

Orange color; I clicked on the Pure Yellow color swatch in the Swatches panel’s Pure folder; 

I selected the Paint Bucket tool, and clicked on the marquee selected to fill in the Yellow 

color. While the selection marquee stayed on, I created a new layer in the Layers panel and 

named it “Mixing Colors;” I clicked the Pure Magenta swatch on the Swatches panel’s Pure 

folder, and clicked on the new layer’s slice selection marquee to fill in the Magenta color, 

finally, I changed the Opacity of the “mixing color” layer to 50%. The Orange color 

appeared.  

2. For the Green color: I first selected the Ring 2 layer; next, I selected the Magic Wand tool 

and clicked on the empty slice for Green color; I clicked on the Pure Yellow color swatch in 

the Swatches panel’s Pure folder; I selected the Paint Bucket tool, and clicked on the 

marquee selected to fill in the Yellow color. While the selection marquee stayed on, I clicked 

the “Mixing Colors” layer to select it; I clicked the Pure Cyan swatch on the Swatches 

panel’s Pure folder; and I clicked on the new layer’s slice selection marquee to fill in the 

Cyan color. The Green color appeared.  

3. For the Violet color: I first selected the Ring 2 layer; next, I selected the Magic Wand tool 

and clicked on the empty slice for Violet color; I clicked on the Pure Magenta color swatch 

in the Swatches panel’s Pure folder; I selected the Paint Bucket tool, and clicked on the 

marquee selected to fill in the Magenta color. While the selection marquee stayed on, I 

clicked the “Mixing Colors” layer to select it; I clicked the Pure Cyan swatch on the 

Swatches panel’s Pure folder; and I clicked on the new layer’s slice selection marquee to fill 

in the Cyan color. The Violet color appeared.  
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For the Tertiary Colors: Yellow-Orange, Red-Orange, Red-Violet, Blue-Violet, Blue-Green, and 

Yellow-Green are the Tertiary Colors, which are the mixtures of the Secondary Colors and their 

adjacent Primary Colors. To facilitate the selection of the Secondary Colors with the Eyedropper 

tool, I first of all press the PrtScr key on the right side of the top edge of the kayboard, to create a 

screen shot with the Color Wheel filled with both Primary and Secondary Colors; I pasted it in 

the file and name the layer “Screen Shot.” I used similar techniques as the ones used for the 

creation of Secondary Color slices. The details are explained below. 

1. For the Yellow-Orange color: I first of all painted the Primary Colors of Yellow at 100% 

Opacity in the Yellow-Onge slice, in the Ring 2 layer; next, I used the Eyedropper tool to 

pick up the Orange color from the “Screen Shot” layer; next, I clicked the “Mixing Colors” 

layer with 50% Opacity to select it; and I used the Paint Bucket tool to fill in the selected 

Yellow-orange color slice in one click; this slice turned into the Yellow-Orange color. 

2. For the Red-Orange color: I first of all painted the Primary Colors of Magenta at 100% 

Opacity in the Red-Orange slice, in the Ring 2 layer; next, I used the Eyedropper tool to pick 

up the Orange color from the “Screen Shot” layer; next, I clicked the “Mixing Colors” layer 

with 50% Opacity to select it; and I used the Paint Bucket tool to fill in the selected Red-

Orange color slice in one click; this slice turned into the Red-Orange color. 

3. For the Red-Violet color: I first of all painted the Primary Colors of Magenta at 100% 

Opacity in the Red-Violet slice, in the Ring 2 layer; next, I used the Eyedropper tool to pick 

up the Violet color from the “Screen Shot” layer; next, I clicked the “Mixing Colors” layer 

with 50% Opacity to select it; and I used the Paint Bucket tool to fill in the selected Red-

Violet color slice in one click; this slice turned into the Red-Violet color. 

4. For the Blue-Violet color: I first of all painted the Primary Colors of Cyan at 100% Opacity 

in the Blue-Violet slice, in the Ring 2 layer; next, I used the Eyedropper tool to pick up the 

Violet color from the “Screen Shot” layer; next, I clicked the “Mixing Colors” layer with 

50% Opacity to select it; and I used the Paint Bucket tool to fill in the selected Blue-Violet 

color slice in one click; this slice turned into the Blue-Violet color. 

5. For the Blue-Green color: I first of all painted the Primary Colors of Cyan at 100% Opacity 

in the Blue-Green slice, in the Ring 2 layer; next, I used the Eyedropper tool to pick up the 

Green color from the “Screen Shot” layer; next, I clicked the “Mixing Colors” layer with 

50% Opacity to select it; and I used the Paint Bucket tool to fill in the selected Blue-Green 

color slice in one click; this slice turned into the Blue-Green color. 

6. For the Yellow-Green color: I first of all painted the Primary Colors of Yellow at 100% 

Opacity in the Yellow-Green slice, in the Ring 2 layer; next, I used the Eyedropper tool to 

pick up the Green color from the “Screen Shot” layer; next, I clicked the “Mixing Colors” 

layer with 50% Opacity to select it; and I used the Paint Bucket tool to fill in the selected 

Yellow-Green color slice in one click; this slice turned into the Yellow-Green color. 



P a g e  | 10 

 

 

Paint Brush and Eyedropper tools, Opacity setting, and Paint Brush size. 

 

The completed Ring 2. 

For Ring 3: I turned on Visibility for the layer Ring 3; I first created the three Primary Color 

slices (Cyan, Magenta and Yellow). I selected the Magic Wand tool and clicked on the empty 

slice for Yellow color; I selected the Paint Brush tool, set the Opacity option at 100%, press the ] 

key to enlarge the tip size so that it was larger than the color slice, and I clicked on the marquee 

of the yellow slice. I repeated the same process for the other two Primary Colors. For the 

Secondary Colors (Green, Orange and Violet), which are mixtures of two neighboring Primary 

Colors, I first used the Magic Wand tool to select the corresponding empty color slices, and Paint 

Brush tool to paint the three Primary Colors selected from the Swatches panel’s Pure folder at 

100% Opacity; next, I changed the Opacity to 50% by dragging its slider leftward or by typing in 

its text field and pressing the Enter key; I painted their neighboring Primary Colors to create the 

Secondary Colors. For the Tertiary Colors (Yellow-Orange, Red-Orange, Red-Violet, Blue-

Violet, Blue-Green, and Yellow-Green), Which are the mixtures of the Secondary Colors and 

their adjacent Primary Colors, I first of all painted the Secondary Colors at 100% Opacity in their 



P a g e  | 11 

 

corresponding empty slices; next, I changed the Opacity to 50%, used the Eyedropper tool to 

pick up one of the Secondary Colors from the Ring 3 layer, and used the Paint Brush tool to paint 

over the selected Primary Color slice in one click; this slice turned into a Tertiary Color; I 

repeated the same steps for the other five empty slices for Tertiary Colors. The Ring 2 has been 

completed. The “50% Opacity” paint mark corresponded to the “translucent layer” instruction 

for the traditional way of using Acryla-Gouache paint and Bristol paper to complete the 

assignment. 

 

The completed Ring 3. 

 

The Visibility for the empty outlined Color Wheel for Ring 4 turned on. 
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For Ring 4: I turned on Visibility for the layer Ring 4. The instruction for the Acryla-Gouache 

paint and Bristol paper assignment indicated that Ring 4 will demonstrate the concept of “Optical 

Mixing” with dots, dashes, thin lines and any other small mark to apply the colors; and that only 

Yellow, Magenta and Cyan should be used. For this Photoshop extra-credit project, I first 

downloaded images of dots from Google Image Search; I selected the one with equal size dots 

and equal distance in between; I opened the file in Photoshop; It was in the Indexed Color mode; 

I went to Image→Mode menu and clicked the CMYK Colors option to change the mode; next, I 

right-clicked the three-stripe icon at the top-right corner of the Layers panel for the drop-down 

menu and selected the New Layer option; I named it Cyan in the New Layer window and clicked 

the OK button; I clicked the lock icon in the Lyer 0 to unlock it for editing; I selected the Magic 

Wand tool, clicked on the white space, and pressed the Delete key on the keyboard to remove the 

white space; I right-clicked for the shortcut menu and selected the Select Inverse option to select 

the dots; next, I selected the Cyan layer and the Pain Bucket tool; I clicked once on any selection 

marquee of tiny dot to fill in all of the dots with Cyan color; next, I repeated the same process to 

create the Magenta and Yellow dots layers. To create different colors with the Cyan, Magenta 

and Yellow dots, I duplicated the layers several times, placed them beneath the empty color 

slices of the Color Wheel in the Ring 4 layer; I used the Move tool and the Up, Down, Left and 

Right Arrow keys on the keyboard to change their location so as to create different effects of 

optical mixing for different colors; and finally, I used a variety of tools, such as Polygonal Lasso 

tool, Magic Wand tool, and Delete key in the keyboard, to clean up extra portions of dots. 

   
Dots patterns found through Google Image Search (left), and Magenta, Cyan, and Yellow dots 

(right) created for optical mixing. 
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The completed Ring 4 with optical mixing of cyan, magenta and yellow dots.  

 

The marble paper sheets and encaustic painting (the top-right piece).  
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The digital 4-Ring CMYK Color Wheel has been completed. The marbled paper sheets and 

encaustic painting works created previously in the instructor’s oil and acrylic painting courses 

have been used as backgrounds for the digital 4-Ring CMYK Color Wheel. Photos of these 

previous works have been edited and converted into grayscale images and pasted under the Color 

Wheel. Notice that the images of the artworks have been recomposed into quadrupled patterns.   

 

 

 

The digital 4-Ring Color Wheel with color and grayscale background; the top one from an 

encaustic painting.  
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The digital 4-Ring Color Wheel with color and grayscale background, based on marbling works.  
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The digital 4-Ring Color Wheel with color and grayscale background, based on marbling works. 
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The digital 4-Ring Color Wheel with color and grayscale background, based on marbling works.   

 

 


